
Software (Panafax Desktop)
Operating Instructions

For Digital Imaging Systems

Before using this software, please carefully read these instructions completely and keep these operating 
instructions in a safe place for future reference.
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General Description
The Panafax Desktop software makes it possible for you to send and receive faxes on a computer by using 
devices connected to the network.

	Documents created on a computer can be faxed from the device.
	 The document does not need to be printed first.

	A message appears on your PC when a Fax is received. The received fax image can be displayed on the 
computer screen.

Email
Server
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Compatible Models

Restriction(s)

-	The size of documents able to be transmitted are restricted to the device's memory storage size. If the memory 
on the device overflows while fax data is being sent from the PC to the device, the transmission is cancelled. 
Adding additional memory (available as an option) is recommended in this case.

-	The maximum number of multi stations (in a Group) per transmission is 999.

-	The total number of stations that a fax message can be transmitted to is limited by the total number of direct 
dialing stations available on the device. The transmission is canceled this number is exceeded during data 
transfer from the PC to the device.

If you are running Anti-virus Software, it may interfere with the Panafax Desktop from sending a PC Fax Job to 
the Device properly. You may be required to temporarily disable the Anti-virus software when using the Panafax 
Desktop. Please consult with your Network Administrator.

Please refer to the Release Note.
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System Requirements
Personal Computer : IBM® PC/AT® and compatibles (CPU Intel® Pentium® 4 1.6 GHz or greater is 

recommended)

Operating System : Microsoft® Windows® 2000 operating system (Service Pack 4 or later)*1, 
Microsoft® Windows® XP operating system (Service Pack 2 or later)*2, 
Microsoft® Windows Server® 2003 operating system (Service Pack 1 or later)*3, 
Microsoft® Windows Vista® operating system*4, 
Microsoft® Windows Server® 2008 operating system*5.

System Memory : Recommended Memory for each OS:

Microsoft® Windows® 2000 operating system	 : 256 MB or more

Microsoft® Windows® XP operating system	 : 512 MB or more
Microsoft® Windows Server® 2003 operating system

Microsoft® Windows Vista® operating system	 : 1 GB or more
Microsoft® Windows Server® 2008 operating system

Interface : 10Base-T/100Base-TX/1000Base-T Ethernet Port, USB Port, Parallel Port
(The interface that can be used is different depending on the model)

CD-ROM Drive : Used for installing the software and utilities from the CD-ROM

Free Disk Space : 300 MB or more (For installation and work space, not including storage space)

*1 Microsoft® Windows® 2000 operating system (hereafter Windows 2000)
*2 Microsoft® Windows® XP operating system (hereafter Windows XP)
*3 Microsoft® Windows Server® 2003 operating system (hereafter Windows Server 2003)
*4 Microsoft® Windows Vista® operating system (hereafter Windows Vista)
*5 Microsoft® Windows Server® 2008 operating system (hereafter Windows Server 2008)

Application Software: Microsoft® Internet Explorer® 6.0 Service Pack 1 or later, 
Microsoft® .NET Framework Version 2.0,
.NET Framework Version  2.0 Language Pack .

*	The following Operating Systems are not supported :
	 Microsoft® Windows Server® 2003 x64 Edition, 
	 Microsoft® Windows® XP x64 Edition, 
	 Microsoft® Windows Vista® 64-bit edition, 
	 Microsoft® Windows Server® 2003 Enterprise Edition for Itanium®-based systems, 
	 Microsoft® Windows Server® 2008 Enterprise Edition for Itanium®-based systems.
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Connection Configuration
There are three types of Panafax Desktop configurations, Send Only System, Send & Receive System 
(Stand-alone Type), and Send & Receive System (Client-Server Type).

Configuration Type Device Setting Panafax Desktop Setting

Send Only System
- Peer To Peer Connection
- Email Server Not Required

- IP Address
- Relay XMT Password
- Relay XMT Report

- Relay XMT Password

Send & Receive System 
(Stand-alone Type)
- Email Server, and Email 
Account Required

- IP Address
- Relay XMT Password
- Internet Fax setting
- Fax Forward setting
- Relay XMT Report

- Relay XMT Password
- POP Receive
- Server setting

Send & Receive System 
(Client-Server Type)
- Shares Network Connection
 (Using Windows shared folder)
- Email Server, and Email 
Account Required

- Relay XMT Password
- POP Receive setting
- Server setting
- Connect Server setting

Send Only System Connection Diagram

aaa bbb
aaa bbb

Transmit

Client PCClient PC

Send Fax

Transfer Fax Data

LAN
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Send & Receive System Connection Diagram (Stand-alone Type)
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Receive Fax
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Send & Receive System Connection Diagram (Client-Server Type)
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Setup Parameters
Panafax Desktop uses the fax modem of your network (LAN) connected device for fax communication.
Before using the Panafax Desktop, the following parameters must be setup onto your device, and PC.

1.	 Confirm the device parameters
	 Make sure that the following device parameters have been set properly in advance. Contact your network 

administrator for details.
	 Parameter names may differ depending on the type of device you are using. 
	 Refer to the Operating Instruction of your device for the Parameter names.

*3 : Fax Parameter (Fax Forward).
The Relay XMT Report can be set in the Fax/Email Settings  Fax Parameters.
Please refer to the device's Operating Instructions for the parameter settings.
 

*2 : Fax Parameter (Relay XMT Report)
The Relay XMT Report can be set in the Fax/Email Settings  Fax Parameters.
Please refer to the device's Operating Instructions for the parameter settings.
 

*1 : User Parameter (Relay XMT Password).
The Relay XMT Password can be set in the Fax/Email Settings  User Parameters.
Please refer to the device's Operating Instructions for the parameter settings.
 

Note:
When configuring with Send & Receive System (Client-Server Type), install the Panafax Desktop on the Client PC, 
and Panafax Desktop Server.

2. Install the Panafax Desktop
Refer to Panasonic Document Management System in the Operating Instruction (For Setting Up) of 
provided booklet. Make sure that the Panafax Desktop menu is selected when installing the software.

3.	 Setup the Panafax Desktop parameters.
	 Follow the instructions on the next page. 

Fax/Email Settings

User Parameters

Fax/Email Settings

Fax Parameters

General Settings - IP Address

- Relay XMT Password*1

- Internet Fax -

- Relay XMT Report = Off*2

- Fax Forward*3 - Set the Panafax Desktop Email address to 
forward the received fax.

Device Parameters
Send 
Only 
System

Send & Receive System
(Stand-alone Type / Client-Server Type)
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Continued on the next page...

Device Setup

Follow the steps below for Client PC, and Panafax 
Desktop Server when configuring the following 
system.

Note:
If the Panafax Desktop main window is shown on your 
PC instead of the confirmation message, select PC 
Fax Device Locator from the Tools menu to open the 
PC Fax Device Locator window. Skip to step 5.

Device Search Ranges window appears.

Click the Search Now  button to start searching 
for the Network Connected Devices.

Click the OK  button.

Double-click the  icon on the Windows 
Desktop.
The device setup confirmation message appears.

-	Send Only System
-	Send & Receive System (Stand-Alone Type)
-	Send & Receive System (Client-Server Type)

Note:
The device locator searches for all the devices within 
the default Subnet. Refine the search range when 
there are many devices connected in the Subnet, or 
you want to connect to a device outside of the default 
Subnet.
To change the search range, click the Add  
button, and specify the IP address range, then click 
the OK  button.

The device locator starts searching for the PC 
Fax devices on the network.

The Network connected PC Fax devices are 
displayed on the PC Fax Device Locator list.

Select the desired device, and double-click, or 
select Properties from the Device menu.
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<Detailed Settings> Tab
Transmission Settings
a) Transmission Priority

If there are multiple devices available, you can 
set the transmission priority of the device. (If 3 
devices are available, select "1" to configure it 
as the highest priority or select "3" to configure it 
as the lowest priority.)

b) Dept. counter mode On
When the Department Code function is being 
used on the device, check the box and input the 
Identification Code.

Click the OK  button to register the settings.

PC Fax Properties window appears.
<General Settings> Tab

PC Fax Settings
-	Device's Relay XMT Password
	 Set the Relay XMT Password of the device.
	 The basic setup is completed. Click the 

OK  button to register the settings.
	 To setup more details, select the Detailed 

Settings Tab.

f

e) Enables Reception
Used for Send & Receive System only. 
See page 15.

c) Result Report Email Address
Specify the Email Address to receive the fax 
transmission result by Email.
To use this function, turn Relay XMT Report 
ON. See page 10.

d) Device's Email Address
Used for Send & Receive System only. 
See page 15.

Reception Settings

Phone Book Setting
f ) Acquires Phone Book data from the device

Check the box to acquire the phone book data 
from the device.
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Using the PC Fax Device Locator, confirm that 
the device is in Standby (this may take a few 
minutes).

Click the  or select Device  Exit from the 
menu to close the PC Fax Device Locator.

For the Send Only System, the setup is 
completed.

For the Send & Receive System, continue to 
Receive Setup in the next section.

NOTE Make sure that the Community Name (1) on the device is set to public  when searching the network 
for devices. If the Community Name (1) is set to a different name, it will be excluded from the search.
If you are unsure of the Community Name, refer to "Operating Instructions (For Device Explorer and 
Embedded Web Server)" or ask your Administrator.
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Receive Setup

Follow the steps below for the Client PC, and Panafax Desktop Server when configuring the following system.

-	Send & Receive System (Stand-Alone Type)
-	Send & Receive System (Client-Server Type)

Double-click the  icon on the Windows 
Desktop.
The Panafax Desktop appears.

Select Tools  PC Fax Device Locator from 
the main menu.

The PC Fax Device Locator appears.
Select Device  Receive/Server Settings 
from the menu.

The Receive/Server Settings appears.
<Receive Settings> Tab

POP Server Settings for PC Fax Reception
Setup these settings to use the Panafax 
Desktop Receive function.
Configure the settings of Email account for the 
reception of Panafax Desktop.

Click the Test  button to confirm the 
setup of the POP server.

Click the OK  button to register the settings.

Select the Server Settings Tab and follow 
the next step when configuring the Send & 
Receive System (Client-Server Type).
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<Server Settings> Tab
Shared Server Settings
When configuring the Send & Receive 
System (Client-Server Type), set the 
following parameters on the Panafax Desktop 
Server.
- Shared Name and Password

Enter the name, and password for the shared 
folder in Panafax Desktop. You can normally 
leave the default settings unchanged.

Click the OK  button when you finish 
inputting the settings.

Note:
	 If a message "Do you want to use the Guest 
Account?" appears, click the Yes  to use it.

	To enable the server function in the server/
client settings of Windows Vista, turn off the User 
Account Control (UAC). After the enabling the 
server function, the User Account Control (UAC) 
can be turned on again.
When the Guest Account is enabled, a security 
problem may occur.
-	It is possible to access common folders even if 

there is no account in Windows.
-	There is a possibility that a computer virus could 

enter through this account.
Select the desired Device, and then double-
click, or click on Properties from the Device 
menu.

PC Fax Properties appears.
Reception Settings

a)	Device's Email Address
	 Set the Email Address of the device for the 

recognition of the device.

b)	Enable Reception
	 Check the box to enable the reception.

Click the OK  button.

Confirm that the Reception status displays 
"Yes". It takes a moment.

Click the  or select Device  Exit from the 
menu to close the PC Fax Device Locator.

The Send & Receive System (Stand-alone 
Type) setup is completed.

For the Send & Receive System (Client-
Server Type), continue to Client Setup in the 
next section.
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Client Setup

Follow the steps below for the Client PC, and when configuring the following system.
-	Send & Receive System (Client-Server Type)

Double-click the  icon on the Windows 

Desktop.

The message of device setup confirmation 
window appears.

Click the OK  button.

Note:
If the Panafax Desktop main window is shown on 
your PC instead of the confirmation message, select 
PC Fax Device Locator from the the Tools menu to 
open the PC Fax Device Locator window. Skip to 
step 3 on page 17.

Device Search Ranges appears.

Click on the Shared Network Connected 
Device(s) option button.

Click the Search Now  button to start searching 
for the shared Server.

Note:
Searching sometimes may take a long time when 
there are many PCs connected to your network. 
If this happens, we recommend you to click the 

Add  button, and specify the Domain or 
Workgroup, or specify the Computer Name directory 
to reduce the search time.

	Specified Domain or Workgroup
	 Input device's Domain, or Workgroup.

	Specified Computer Name
	 Input the Server Computer Name.

	Shared Name
	 Input the Server Shared Name if you changed 

from the default setting.

	Password
	 Input the Server Password if you changed 

from the default setting.
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Start searching the Server for Network 
connected Devices.

The Network connected Device via Server is 
listed in the PC Fax Device Locator.

Click the  or select Device  Exit from the 
menu to close the PC Fax Device Locator.

The Send & Receive System (Client-Server 
Type) setup is completed.
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Main Window and Toolbar
Main Window

1.	 Fax No.
	 Enter the destination fax number.

2.	 Line Select
	 Check the line type to dial the preset code before 

the telephone number. See the Dialing Settings 
Tab of Configuration Menu.

3.	 Recipient
	 When this is entered, it appears on the cover 

sheet.

4.	 Company
	 When this is entered, it appears on the cover 

sheet.

5.	 XX recipient(s)
	 Indicates the number of entered station(s).

6.	 Destination(s)
	 Indicates entered destination station(s).

7.	 Subject
	 When this is entered, it appears on the cover 

sheet.

8.	 Memo field
	 When this is entered, it appears on the cover 

sheet.

9.	 Cover Sheet
	 Select from various cover sheet, or no cover 

sheet.

10.	Attachment
	 Indicates the number of pages attached.

11.	Resolution
	 Indicates the current sending resolution.

Using Panafax Desktop
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Toolbar

Used to start the transmission.

Used to view the cover sheet, or transmission file.

Used to select the file to be sent.

Used to show the Send Log, and Receive Log.

Used to open your personal Phone Book.

Used to create, or edit a Cover Sheet.

Used to show the On-line help.
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Sending Documents
Sending a Document via a Windows Application

You can send a fax directly from any Windows Application by simply printing to the Panafax Desktop Driver. 
For example, compose a document with your word processor application. When you finish the preparation, and 
ready to fax it to a remote location, simply follow the procedure below.

From the current software (in our example, your 
word processor application), select Print from 
the File menu.

The Print dialog box appears.
Select Panafax Desktop Driver from the 
Printer Name menu.

Click the OK  button to convert the 
document into a fax image.

Note:
The settings available within the Properties  
button may differ depending on the versions of 
Windows you are running. As you should not 
normally need to modify these settings, please leave 
the default settings unchanged.

Enter the Fax No., or select a destination from 
your Personal Phone Book.

Note:
To input a pause, use the comma ",".

Click the  button to add a recipient into the 
recipient list.
Enter/select another recipient if you desire.
Type the Recipient, Company and/or Subject 
to be included on the Cover Sheet.

Click the  icon when ready to send the 
fax.

Note:

Click the  icon to verify that the fax image 

is sent to the correct remote station(s).

Click the OK  button to start the 
transmission.
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Sending a Document via the Panafax Desktop

You can send a fax directly from a file made in any Windows Application by simply attaching the file via the 
Panafax Desktop.
For example, compose a document from your word processor application. When you finish the preparation, and 
ready to fax it to a remote location, simply follow the procedure below.

Select the file, and click the Open  button 

to convert the document into a fax image.

Double-click the  icon on the Windows 
Desktop.
The Panafax Desktop window appears.

Click the  icon to select a file for the 

transmission.

From the Panafax Desktop window, enter the 
Fax No., or select a destination from your 
Personal Phone Book.

Note:
To input a pause, use the comma ",".

Click the  button to add a recipient into the 

recipient list.

Enter/select another recipient if you desire.
Type the Recipient, Company and/or of the 
memo message to be included on the Cover 
Sheet.

Click the OK  button to start the 

transmission.

Click the  icon when ready to send the 
fax.

Note:

Click the  icon to verify that the fax memo 
is sent to the correct remote station(s).
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Sending a fax memo by Panafax Desktop

You can send a fax memo quickly and easily, directly from the Panafax Desktop.

From the Panafax Desktop window, enter 
the Fax No: or select a destination from your 
Personal Phone Book.

Note:
To input a pause, use the comma ",".

Type the Recipient, Company and/or of the 
memo message to be included on the Cover 
Sheet.

Enter/select another recipient if you desire.

If you wish, click Cover Sheet to change the 
Cover Sheet Type.

Click the  button to add a recipient into the 
recipient list.

Click the  icon when ready to send the 
fax.

Note:

Click the  icon to verify that the fax memo 
is sent to the correct remote station(s).

Click the OK  button to start the 
transmission.

Double-click the  icon on the Windows 
Desktop.
The Panafax Desktop window appears.
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Receiving Documents
Receive Setting

Confirm that the Panasonic Communications 
Utility icon is in the taskbar tray.

Right-click the Panasonic Communications 
Utility Icon to show the menu, and select the 
PC-Fax Reception Notification.

	Popup Display

	Icon Display

	No Notice

When a fax is received on the machine, it will 
proceed as follows:

A reception notice appears on the connected 
PC. Click the Receiving LOG  button.

The Panasonic Communications Utility icon 
changes its appearance.
Double-click the icon.

or

The received fax is displayed on the PC.

Note:
Your PC opens it with the application that is 
associated with the TIFF file.

The Receive Log appears.

Select a transaction from the log, then click the 

 icon to view the received fax.
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Registering the Personal Phone Book
To register a recipient into the Personal Phone Book, follow the steps below:

In the <Data Fields> Tab
Enter the Company Name, Department, Job 
Title, Address, Direct Phone No., and the 
Extension Phone No. of the recipient to be used 
on the Cover Sheet.

In the <Contact> Tab
	Name:
	 Enter the recipient's name.
	Fax No.:
	 Enter the fax number.
	Call Type:
	 Select how the call should be dialed. The code 

preset with the Tools/Configuration/Dialing 
Settings is dialed ahead of the fax number.

Note:
To input a pause, use the comma (,).

Click the New  button.

Note:
	Click the Acquire Device's Phone Book  button 
to retrieve the phonebook data from the device. 
To use this function, the device setting is required. 
See page 12, "Detailed Settings Tab/ Phone Book 
setting".

	Click the Edit  button to edit the address.

	Click the Delete  button to delete the address.

Click the  icon to open the Phone Book 

dialog Box.

Click the OK  button to save the entry.
The maximum number of entries are 2000.
To add another entry, repeat the procedure 
from step 2.
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To register a group of recipients, follow the steps below:

Click the  icon.

The Add New Group Name dialog box appears.
Enter the group name, and then click the 

OK  button.

The Group registration dialog box appears.

Click the New  button.

The Phone Book dialog box appears.

Click the Edit Group  button.

Select the desired recipients.

Click the >>  button to add the 
recipient(s) to the Member List.
The maximum number of recipients is 999 for 
each group.
To add another group, repeat the procedure 
from step 3.
The maximum number of groups is 100.

If finished, click the OK  button to exit 
Group registration.
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You can import/export your Personal Phone Book data.

Note:
Though a pause usually is indicated by a comma (,) with Panafax Desktop it is changed to a "p" by the Import, and Export 
of the CSV file. Please input a pause using a "p" when creating a CSV file.

To import/export the Phone Book entries, the data must be in CSV (Comma Separated Value) format. Follow 
the procedures shown below to register the Personal Phone Book.

In the Phone Book dialog box, Select File  
Import... from the menu.

Select the separator type of CSV file, and then 
click the OK  button.

Importing the Personal Phone Book from the CSV file

Select the file to be imported, and then click the 
Open  button.

Note:
	Name and Fax No: of the Address book field are 
essential (minimum requirements).

	 Please remove the check box of any unnecessary 
Address book Field(s).

	Use only effective characters in the Fax No: field.
	 The phone data will be ignored, and not be imported 

if they contain any of the prohibited characters. 
Please see below for the effective characters.

	 Effective characters: 1234567890*#p-/
	 p = Pause
	 - = Separation mark (Not used for dialing)
	 / = Tone changes

Confirm that the contents of the Data Field and 
Address book Field match.
Select the Data Field you want to import to.
Select the item, and click the Change Mapping...  
button to change the field setting if the Data 
Field, and Address book Field do not match.

Click the OK  button when finished.

The telephone data the CSV file is imported 
into your Phone Book.
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Exporting to the CSV file

Select the separator type of CSV file, and then 
click the OK  button to save the CSV file.

Enter the file name, and then click 
the Save  button.

On the Phone Book dialog box, Select File  
Export... from the menu.
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Cover Sheet
The Cover Sheet is attached to the first page of every fax, and contains information such as the recipient's 
name, sender's name, date, title, etc.

Creating a Cover Sheet

The Cover Sheet Editor window appears.
Edit the Cover Sheet.
Select Save As from the File menu.

Click the  icon.

The Save As dialog box appears.
Select the Folder you wish to save to, or save 

to a New Folder, click the New Folder  button, 
enter the New Folder Name, and then click the 

OK  button.

Enter the New Folder Name into the Cover 
Sheet File Name box.
Enter any comments into the Comment box if 
you wish.

Click the Save  button to save the New 
Cover Sheet.
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[Edit] menu

Undo Undoes the last editing operation.

Cut Deletes the selected text, and copies it to the clipboard.

Copy Copies the selected text onto the clipboard.

Paste Pastes the text, or object from the clipboard.

Delete Object Deletes the selected object.

Page Size Sets the size of the cover sheet.

Date Frame Inserts a date field.

Text Frame Inserts a text box.

Line/Box Inserts a line or box.

Image Frame Inserts an existing image file (bmp file).

Recipient Details

Sender Details Inserts the information set in the Sender Details  tab in the Tools menu.

Inserts the information set in the Contact  and Data Fields  tabs in the Personal 
Address Book.

Comments Inserts a Comment field for typing a brief message when sending a fax.

Subject Inserts a Subject field when sending a fax.

[View] menu

Show Grid Displays a grid.

Preview Displays a preview of the cover sheet.

Show Status Bar Displays the status bar.

Zoom Sets the ratio for the cover sheet editing screen.

Scale unit Sets the scale unit of measure (cm/inch).

[Options] menu

Font Specifies the character font.

Line Style Specifies the line style.

Text Alignment Adjusts the text position.

Date Format Sets the date format.
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Configuration Menu
Configuration Setting

Selecting Configuration... in the Tools menu, displays the Configuration window.

a

b

c

d

Send Option Tab
Device Selection
a) Device Name:

A device can be chosen here when more than 
one device is connected with network connected 
type devices.

Auto Selection Effective device is selected 
automatically by the priority 
setting order.

Rotation Effective device is selected 
automatically in rotation 
order. (load balancing)
Note:
Available if multiple devices are 
set for the Panafax Desktop.

Device Name Only the designated device 
is selected.

b) Status/Location/Paper Size/Resolution:
When the device is specified, the attributes of 
the device are indicated.

Quality
c) Resolution:

Resolution to be used for the transmission.
The selectable resolutions are dependent on the 
capability of the device connected to your PC.

d) Selects these settings each time a fax is sent:
If this box is checked, the setting window 
displays each time a fax is sent.
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Continued on the next page...

Dialing Settings Tab
Specify the local, long distance and Inter-office call 
access numbers. These access numbers are dialed 
before the phone numbers that are registered in the 
Personal Address Book depending on the Call Type 
settings.

Cover Sheet Tab
Specifies how the Cover Sheet is used.

Cover Sheet with No specified fields (Generic)
The address information is not inserted into the TO 
field of the Cover Sheet.
The transfer to the device is done efficiently 
because the image data is sent to the device only 
once, and only the address information is sent in 
the case of multi-station transmission.

Cover Sheet with specified fields
The address information is inserted into the TO 
field of the Cover Sheet.
The transfer time to the device is sometimes 
long because the image data is sent to the 
device multiple times in the case of multi-station 
transmission.

Sender Details Tab
Used to identify senders from various information on 
the Cover Sheet when sending a fax.

PIN Code Tab
Specify the PIN Code settings when required by your 
telephone system.
Some countries do not support this function.
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Various Settings Tab
Device Phone Book
When this box is checked, the phone book data is 
acquired from the device at the time of startup, and 
it is appended into the Personal Phone Book.
When this is used on the client & server, this 
function operates only on the server PC.
To use this function, the device setting is required. 
See page 12, "Detailed Settings Tab/ Phone Book 
setting".

Notification Message
Various notices can be set up.
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Send Log/Receive Log
Send/Receive Log

Click the  icon.

Send/Receive Log window appears.

Click the  icon, and  icon to 

switch between the Log windows.

Result

OK The fax transmission has been 
completed from the device.

Information 
Code

The fax transmission has been 
incomplete from the device.

Status

Queuing The send job is queuing to 
transfer data to the device.

Executing The send job is executing after 
the data is transferred to the 
device.

Completed The send job is completed. Note:
	For the Send Only System, the Receiving Log is 
not available.

	For the Send & Receive System (Client-Server 
Type), there is an Administrator Send Log that 
can check all the client's sending transactions. 
Select General User to see the Own Send Log, 
and Administrator to see the Administrator Send 
Log. The Administrator Send Log can be setup with 
a password for security. To see the Administrator 
Send Log, Login with Administrator mode, and 
select the Display All Users Send Logs from the 
View menu.
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Save Log

The Send/Receive Log can be saved to a separate file.
At the default setting, when the log exceeds 999 transactions, the oldest entry is automatically deleted. The log 
can be saved by following the steps below.

Manually Saving the Log

In the Log window, select the log transactions 

that you wish to save and click the  icon.

Select the Folder that you want to save into, 
and then click the OK  button.

You can make a new folder by clicking the 

Make New Folder  button.

Select whether you wish to Delete the Logs 
after saving them.

The TIFF file data (.tif), and the transmission 
file log information file (.xml) are saved as a set.
The log list files (sendlog.html/recvlog.html) are 
made automatically in the same folder. They 
can be viewed with a Web browser (Internet 
Explorer 6.0, or later).
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In the Log window, select Tools  Options 
from the menu.

Option window appears.
Set the Save Send/Receive Log settings 
accordingly.

Number of Saved Send/Receive Logs
Specify the number of log entries to save. 
Once the specified number of entries is 
exceeded, the old log entries are either 
overwritten, or are saved to the specified 
location.

Saves the exceeded logs automatically
Check to save logs into the outside when it 
exceeds the number setup.

-	Location
	 Specify the folder of save logs. This setting 

operates when you select Save Windows 
Folder, or Document Manager Share folder.

-	Windows Folder
	 Check if you want to save logs into the 

window folder.
	 Create HTML Log List
	 Check to create HTML log list (sendlog.html/

recvlog.html) every log entry.

-	Document Manager
	 Check if you want to save logs on the 

Document Desktop of Document Manager.
	 Share folder
	 Check if you want to save logs on the Share 

Folder of Document Manager.

Automatically Saving the Log
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Problem Solving
Mode Symptom Possible Cause/Action

Sending Documents When sending a document, an 
error occurs immediately. It is 
indicated with "Other error" in 
the Send Log file.

- Is the Relay XMT Password setup properly?
A document will not be transmitted properly if the 
Relay XMT Password does not match with the 
password of the device in the setup mode.

- Is the Relay Domain registered in the device?
If the Relay Domain is registered in the device, 
the transmission cannot be accepted unless the 
registered Relay Domain matches with the Panafax 
Desktop Email Address. If this happens, register 
the new Relay Domain into the device as explained 
below. (See page 12)
In case the Result Report Email Address is not 
set;
Register the Relay Domain as below;
panafax_desktop
In case the Result Report Email Address is set;
Register the same Relay Domain of the Result 
Report Email Address.
Ex: If the Result Report Email Address is set to 
abcdef@network.com, set the Relay Domain as 
network.com.

The result of the transmission 
is "Unknown".

- Is Anti-virus software running?
If you are running an anti-virus software, it may 
interfere with the Panafax Desktop sending a PC 
Fax job to the device. Check the settings of the 
anti-virus software, and refer to the readme file 
for more details.

Receiving Document It cannot receive at all. - Check whether the device setup is transferred 
(Fax Forward) to the Panafax Desktop Email 
Address.
(See page 10)

- Check the Receive setting of Panafax Desktop.
(See page 14)

Appendix
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PANASONIC COMMUNICATIONS COMPANY OF NORTH AMERICA MAKES NO WARRANTIES, 
GUARANTEES OR REPRESENTATIONS, EXPRESSED OR IMPLIED, TO THE CUSTOMER WITH 
RESPECT TO THIS PANASONIC MACHINE, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED 
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

PANASONIC COMMUNICATIONS COMPANY OF NORTH AMERICA ASSUMES NO RISK AND SHALL 
NOT BE SUBJECT TO LIABILITY FOR ANY DAMAGE, INCLUDING, BUT NOT LIMITED TO DIRECT, 
INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OR LOSS OF PROFITS 
SUSTAINED BY THE CUSTOMER IN CONNECTION WITH THE USE OR APPLICATION OF THIS 
PANASONIC MACHINE. SEE YOUR DEALER FOR DETAILS OF DEALER’S WARRANTY.

USA Only

WARRANTY

For Service, Call:

Panasonic Communications Company of North America,
Unit of Panasonic Corporation of North America
One Panasonic Way
Secaucus, New Jersey 07094
http://panasonic.co.jp/pcc/en/

Panasonic Canada Inc.
5770 Ambler Drive
Mississauga, Ontario L4W 2T3
http://www.panasonic.ca

For Customer Support (Except for
USA and Canada Users):
Panasonic Communications Co., Ltd.
Fukuoka, Japan
http://panasonic.net

I0305-13128 (05)
PJQMC0380UA
December 2008
Published in Japan
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